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Overview

• Implicational hierarchies and Guttman scaling—the basics
• Overview of recent work using ValPaL data
• Applying Guttman scaling and significance tests to the subordination

data of Cristofaro (2003), Subordination (O.U.P)
• deriving a scale
• handling missing data by imputation
• significance testing

• Summary of empirical findings
• Summary of theoretical results



Implicational hierarchies and Guttman
scaling—the basics



A more systematic approach to implicational scales:
Guttman scaling and significance testing

• Guttman scale (Guttman 1944)
• A measure of the one-dimensionality of a dataset
• Originally used in studies of attitudes
• Scalogram: 1‘s (presence) and 0‘s (absence) of an 

attribute for a given individual
• The scalogram is arranged such that the margins are 

hierarchical
• The implicational scale now appears
• The Guttman Coefficient is the total number of filled 

cells, T, minus the number of errors divided by T

Louis Guttman
(1916-87)



Overview of recent work using ValPaL data



Tsunoda‘s verb hierarchy

Direct Effect > Perception > Pursuit > Knowledge > Feeling > 
Relationship > Ability

Passive, antipassive, reflexive, and reciprocal more frequent towards the left 
(Tsunoda 1985)



Data and methods for studying implicational 
scales for verb meanings in general and the 
Tsunoda hierarchy in particular

Based on 
Wichmann, Søren. 2016. Quantitative tests of implicational verb hierarchies.

In: Kageyama, Taro and Wesley M. Jacobsen (eds.), Transitivity and Valency
Alternations: Studies on Japanese and Beyond. Berlin: De Gruyter Mouton. (In press).

Wichmann, Søren. 2015. Statistical observations on implicational (verb) hierarchies. 
In: Malchukov, Andrej and Bernard Comrie (eds.), Valency Classes in the World's 
Languages, 155-181. Berlin: De Gruyter Mouton. 



The Leipzig Valency Classes Project

• Over 30 contributors provided us with data on the valency properties 
of a selected sample of 80 (verb) meanings in individual, 
genealogically and structurally diverse languages

• Contributors were asked to provide information about any valency 
alternation undergone by these verbs



Locations of languages in the database



Verb meanings corresponding to Tsunoda’s hierarchy

Direct Effect KILL, BREAK, HIT, EAT
Perception SEE, HEAR, LOOK AT
Pursuit SEARCH FOR
Knowledge KNOW
Feeling LIKE, FEAR
(Relationship none attested in database)
(Ability none attested in database)



MEET HUG SEE HELP TAKE BUILD PEEL RUN FEEL 
PAIN

sum

Bora 1 1 1 1 1 1 0 1 0 7
Hoocak 1 1 1 1 1 0 1 0 0 6
Chintang 1 1 1 1 1 0 0 0 0 5
Yucatec
Maya 1 1 1 1 1 0 0 0 0 5
German 1 1 1 1 0 0 0 0 1 5
Icelandic 1 1 1 1 0 0 0 0 0 4
Arabic 0 1 1 0 0 0 0 0 0 2
Even 1 0 0 0 0 0 0 0 0 1
sum 7 7 7 6 4 1 1 1 1

Guttman scaling, 1st step: arrange data
(example: subset of data for Reciprocal)



MEET HUG SEE HELP TAKE BUILD PEEL RUN FEEL 
PAIN

sum

Bora 1 1 1 1 1 1 0 1 0 7
Hoocak 1 1 1 1 1 0 1 0 0 6
Chintang 1 1 1 1 1 0 0 0 0 5
Yucatec
Maya 1 1 1 1 1 0 0 0 0 5
German 1 1 1 1 0 0 0 0 1 5
Icelandic 1 1 1 1 0 0 0 0 0 4
Arabic 0 1 1 0 0 0 0 0 0 2
Even 1 0 0 0 0 0 0 0 0 1
sum 7 7 7 6 4 1 1 1 1

Guttman scaling, 2nd step: count errors
of inclusion or omission (here 4)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1

errors 8

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2

errors 8 7

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2

errors 8 7 8

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3

errors 8 7 8 7

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3

errors 8 7 8 7 8

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3

errors 8 7 8 7 8 9

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4

errors 8 7 8 7 8 9 8

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5

errors 8 7 8 7 8 9 8 7

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6

errors 8 7 8 7 8 9 8 7 6

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6 6

errors 8 7 8 7 8 9 8 7 6 7

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6 6 7

errors 8 7 8 7 8 9 8 7 6 7 6

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6 6 7 8

errors 8 7 8 7 8 9 8 7 6 7 6 5

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6 6 7 8 9

errors 8 7 8 7 8 9 8 7 6 7 6 5 4

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6 6 7 8 9 9

errors 8 7 8 7 8 9 8 7 6 7 6 5 4 5

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6 6 7 8 9 9 9

errors 8 7 8 7 8 9 8 7 6 7 6 5 4 5 6

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



DATA 1 1 0 1 0 0 1 1 1 0 1 1 1 0 0

ones 1 2 2 3 3 3 4 5 6 6 7 8 9 9 9

errors 8 7 8 7 8 9 8 7 6 7 6 5 4 5 6

Guttman scaling, 2nd step: count errors
of inclusion or omission (algorithm)



Guttman scaling, 3rd step: calculate the
Guttman coefficient

GC = 1 – (errors/filled cells)

our example: 

GC= 1 – (4/72) = 0.94 

(GC ≥ 0.85 conventionally taken to imply scalarity)



Guttman scale for the alternations of Tsunoda
SEE2

> KILL1
> HIT1

> LOOK AT2
> KNOW4

> EAT1
> HEAR2

> BREAK1
> SEARCH FOR3

> LIKE5
> FEAR5

> WANT5

Guttman Coefficient: 85.6%



Need for a statistical test for implicational 
hierarchies 
• Can we trust that a Guttman coefficient

of > 85% implies scalarity?

• Pick between 3 and 300 random columns for some alternations in some 
languages, create scalograms and measure the GC

• 81.7% of the subsamples have a GC of 85% or greater!



How the statistical test works

• Compute the GC for a given matrix
• Make 99,999 randomizations of the matrix keeping the margins (sums 

of rows and columns) constant*
• R = how often a GC greater or equal to the one of the original matrix 

if found
• If R / 100,000 ≤ 0.05 the GC is significant

*The function permatfull of the vegan package of R can  be used here



Results and conclusions of Wichmann (2016, 2015)

• There is, indeed, implicational hierarchies among verbs according to 
how they participate in different constructions across languages

• But the exact shape of Tsunoda‘s hierarchy could not be confirmed
• Hierarchies are only vaguely similar across constructions
• Verbs don’t fall neatly into classes—assuming the existence of such 

classes in the absence of evidence is problematical
• An outstanding problem: how to handle missing data when testing for 

significance?



More recent work using data on coding
frames from ValPaL
• Background: the curious history of Aldai, Gontzal and Søren

Wichmann. Submitted. Statistical observations on hierarchies of 
transitivity. Folia Linguistica.



A solution to the problem of missing data

• Go to each empty cell, first puts in a 0 and then a 1 and choose the value 
that results in a GC closest to GCorig

• First do this columnwise then rowwise
• Then choose the matrix with the best approximation to GCorig
• Now the GC will normally be quite close (< 0.1%) to GCorig. But 

improvements are sought, as follows: 
• randomly select a cell that was previously empty
• change the 0 to 1 or the other way around
• accept the edit if the difference between the new GC and GCorig diminishes
• or discard it when the difference does not diminish
• continue this process N number of times or until GC = GCorig (N = 1000 will suffice)



Definitions

• For verbs typically taking two partipants it is noted whether they take 
one or more of the following 4 coding classes, resulting in 4 data 
matrices:

• 1-2 or ‘transitive’: the two participants are coded like the two main 
arguments of the prototypical transitive verbs, i.e. BREAK, KILL, DESTROY, etc.

• 1-3 or ‘oblique-object’: the undergoer is coded in an oblique way, possibly 
involving the dative or other oblique case

• 1-3LOC or ‘locative-object’: the undergoer takes an oblique case-marker 
exclusively (or almost exclusively) used for location, and particularly for static 
location

• 3-1 or ‘inverted frame’: the actor takes a non-canonical marking, such as DAT 
or OBL, whereas the proto-patient participant usually appears in the NOM or 
ABS case



Software demonstration

R script and data at:
https://github.com/Sokiwi/Guttman



Implicational scale for the transitive class

• BREAK1, CUT, EAT1, KILL1 > FRIGHTEN > BEAT, HIT1, WASH > GRIND, SEE2 > COOK, 
HUG > KNOW4 > PEEL, TOUCH, SMELL > SEARCH FOR3, HEAR2 > BUILD, COVER, 
DIG, FOLLOW, LIKE5 > SHAVE, HELP > FILL, LOOK AT2 > MEET, FEAR5 > DRESS > 
LEAVE > SHOUT AT > THINK > CLIMB > GO > SIT DOWN, SIT, LIVE

Guttman coefficient: 94.41, p = 0.0001



Comparing the Tsunoda hierarchy with results
for alternations1 and transitive coding frames2

SEE2
KILL1
HIT1
LOOK AT2
KNOW4
EAT1
HEAR2
BREAK1
SEARCH FOR3
LIKE5
FEAR5

1Wichmann (2016); 2Aldai & Wichmann (under review)

BREAK1
EAT1
KILL1
HIT1
SEE2
KNOW4
SEARCH FOR3
HEAR2
LIKE5
LOOK AT2
FEAR5

Alternations: 1-2 coding:



Implicational scales for the intransitive coding
classes2

1-3 (Guttman coefficient: 94.57, p = 0.0002)
• SHOUT AT > FOLLOW, HELP > LOOK AT2 > GO > FEAR5, CLIMB, SIT DOWN, LIVE, HUG > LIKE5, 

LEAVE, HEAR2, SIT, TOUCH > THINK, SEARCH FOR3, EAT1, MEET, KNOW4, DRESS, SHAVE, SMELL, 
WASH, BEAT, BREAK1, BUILD, COOK, COVER, CUT, DIG, FILL, FRIGHTEN, GRIND, HIT1, KILL1, PEEL, 
SEE2

1-3LOC (Guttman coefficient: 95.54, p = 0.0001)
• SIT, LIVE > SIT DOWN > GO > LEAVE > CLIMB > THINK > FEAR5, SMELL > DIG, FILL, SHOUT AT, 

HEAR2, SEARCH FOR3 > MEET, LIKE5, SHAVE, FOLLOW, EAT1, BEAT, BREAK1, BUILD, COOK, COVER, 
CUT, DRESS, FRIGHTEN, GRIND, HELP, HIT1, HUG, KILL1, KNOW4, LOOK AT2, PEEL, SEE2, TOUCH, 
WASH

3-1 (Guttman coefficient: 99.27, p = 0.4967)
• LIKE5 > HEAR2 > SEE2 > KNOW4 > MEET, FEAR5, LOOK AT2 > BEAT, BREAK1, BUILD, CLIMB, COOK, 

COVER, CUT, DIG, DRESS, EAT1, FILL, FOLLOW, FRIGHTEN, GO, GRIND, HELP, HIT1, HUG, KILL1, 
LEAVE, LIVE, PEEL, SEARCH FOR3, SHAVE, SHOUT AT, SIT, SIT DOWN, SMELL, THINK, TOUCH, WASH

2Aldai & Wichmann (under review)



Cristofaro’s data on subordination hierarchies



Stipulations

• “By subordination will be meant a situation whereby a cognitive
asymmetry is established between linked SoAs [state of affairs], such that
the profile of one of the two (henceforth, the main SoA) overrides that of 
the other (henceforth, the dependent SoA). This is equivalent to saying that
the dependent SoA is (pragmatically) non-asserted, while the main one is 
(pragmatically) asserted.”

• Subordinate construction types include complements, adverbials, and
relatives.

• Balanced: the expression of the subordinate SoA same as that of the main
clause

• Deranked: the expression of the subordinate SoA different from that of the
main clause



Parameters of deranking

• Verbs coding dependent events may not display all the of the
categorial distinctions normally carried by verbs in the language, such
as tense, aspect, mood, person

• Categorial distinctions may be expressed by means of special forms
(subjunctive, dependent mood, etc.)

• Morphology not allowed on in verbs in independent declarative
clauses may occur (e.g., case marking)

• Participants may not be overtly expressed, or expressed as possessors
or obliques



Sampling

• A variety sample of 100 languages, selected according to the method
proposed in Rijkhoff et al. (1993), using the classification of Ruhlen
(1987). Subsequently reduced to 80 languages for which sufficient
information was available.



An example
(top of one of the tables said support an implicational hierarchy)

Des = Desideratives (want to)
Know. = Knowledge (know that)
Man. (‘make’) = Manipulatives (make)
Man. (order’) = Manipulatives (order)
Mod. = Modals (can, must)
Perc. = Perception (see someone Xing)
Phas. = Phasals (begin to)
Prop.a. = Propositional attitude (believe that)
Utt. = Utterance (say that)



Not clear exactly how Cristofaro gets from the 
raw data to the implicational scales
• How are cases of -/+ handled?
• How are missing data handled?
• How is information from the many tables combined?



Let’s apply a more consistent procedure

• Encode all tables in text files
• Apply computational Guttman scaling to each of them
• Discard the ones that are not significant
• Correlate scales for the remaining ones
• If scales have significant correlations compute rankings across tables
• Compare the results with Cristofaro’s scales



Mod Phas Des Man make Man order Perc Know Prop Utt

Akan NA NA NA NA 1 0 0 NA 0

Arabic_Gulf NA NA NA NA NA NA NA NA NA

Barasano 1 1 NA NA 1 1 0 0 0

Basque 1 1 1 NA NA 1 0 0 0

Berbice_Dutch_Creole 1 1 1 NA NA 1 0 0 0

Borana 1 1 1 NA NA 1 0 0 0

Burushaski 1 1 1 1 1 1 1 NA 0

Canela_Kraho NA NA NA 0 0 NA NA NA 0

Recoding of the data
cases of -/+, °, and missing data
all encoded as NA

Des = Desideratives (want to)
Know. = Knowledge (know that)
Man. (‘make’) = Manipulatives (make)
Man. (order’) = Manipulatives (order)
Mod. = Modals (can, must)
Perc. = Perception (see someone Xing)
Phas. = Phasals (begin to)
Prop.a. = Propositional attitude (believe that)
Utt. = Utterance (say that)



Example of result of Guttman scaling:
Complement relations, lack of tense distinctions 

GS ranking
Mod 1
Phas 2
Des 3
Man order 4
Perc 5
Man make 6
Know 7
Prop 9
Utt 9

GCorig GCimpp 1s 0s sum
98.06 98.09 0.0001 117 192 309



Complement relations: Guttman scaling, all tables
data GCorig GCimp p 1s 0s sum
lack of T distinctions 98.06 98.09 0.0001 117 192 309
lack of A distinctions 97.31 97.30 0.0007 104 268 372
lack of M distinctions 96.06 96.09 0.0001 113 217 330
T distinctions expressed differently from independent clauses 95.65 95.06 0.5332 13 10 23
A distinctions expressed differently from independent clauses 96.3 95.83 0.8437 19 8 27
M distinctions expressed differently from independent clauses 100.00 100.00 1 12 15 27
lack of person agreement distinctions 96.12 96.14 0.0004 68 138 206
person agreement distinctions expressed differently from independent clauses 100.00 100.00 1 15 11 26
case marking / adpositions on verbs 93.40 93.24 0.0041 47 59 106
lack of overtly expressed arguments A and S 93.48 93.53 0.0004 125 243 368
Arguments A and S coded as possessors 100.00 100.00 1 10 9 19



Digression, why GC = 100 and p = 1?
data GCorig GCimp p 1s 0s sum
lack of T distinctions 98.06 98.09 0.0001 117 192 309
lack of A distinctions 97.31 97.30 0.0007 104 268 372
lack of M distinctions 96.06 96.09 0.0001 113 217 330
T distinctions expressed differently from independent clauses 95.65 95.06 0.5332 13 10 23
A distinctions expressed differently from independent clauses 96.3 95.83 0.8437 19 8 27
M distinctions expressed differently from independent clauses 100.00 100.00 1 12 15 27
lack of person agreement distinctions 96.12 96.14 0.0004 68 138 206
person agreement distinctions expressed differently from independent clauses 100.00 100.00 1 15 11 26
case marking / adpositions on verbs 93.40 93.24 0.0041 47 59 106
lack of overtly expressed arguments A and S 93.48 93.53 0.0004 125 243 368
Arguments A and S coded as possessors 100.00 100.00 1 10 9 19



Original matrix



Transposed matrix



Rearranged matrix



Imputed matrix



Mathematically impossible to randomize
this keeping sums of rows and columns constant



Mathematically impossible to randomize
this keeping sums of rows and columns constant



Mathematically impossible to randomize
this keeping sums of rows and columns constant



Mathematically impossible to randomize
this keeping sums of rows and columns constant



Mathematically impossible to randomize
this keeping sums of rows and columns constant



Mathematically impossible to randomize
this keeping sums of rows and columns constant



Mathematically impossible to randomize
this keeping sums of rows and columns constant



Mathematically impossible to randomize
this keeping sums of rows and columns constant



What to do with cases where GC = 100, then?

• No good solution at present
• Arbitrary decision: accept as significant a table if the number of 

datapoints exceeds 100



Complement relations: Guttman scaling, all tables
data GCorig GCimp p 1s 0s sum
lack of T distinctions 98.06 98.09 0.0001 117 192 309
lack of A distinctions 97.31 97.30 0.0007 104 268 372
lack of M distinctions 96.06 96.09 0.0001 113 217 330
T distinctions expressed differently from independent clauses 95.65 95.06 0.5332 13 10 23
A distinctions expressed differently from independent clauses 96.3 95.83 0.8437 19 8 27
M distinctions expressed differently from independent clauses 100.00 100.00 NA 12 15 27
lack of person agreement distinctions 96.12 96.14 0.0004 68 138 206
person agreement distinctions expressed differently from independent clauses 100.00 100.00 NA 15 11 26
case marking / adpositions on verbs 93.40 93.24 0.0041 47 59 106
lack of overtly expressed arguments A and S 93.48 93.53 0.0004 125 243 368
Arguments A and S coded as possessors 100.00 100.00 NA 10 9 19



Complement relations: significant tables

data GCorig GCimp p 1s 0s sum
lack of T distinctions 98.06 98.09 0.0001 117 192 309
lack of A distinctions 97.31 97.30 0.0007 104 268 372
lack of M distinctions 96.06 96.09 0.0001 113 217 330
lack of person agreement distinctions 96.12 96.14 0.0004 68 138 206
case marking / adpositions on verbs 93.4 93.24 0.0041 47 59 106
lack of overtly expressed arguments A and S 93.48 93.53 0.0004 125 243 368



Complement relations: correlations
data data rho p
lack of T distinctions lack of A distinctions 0.94 0.0001
lack of T distinctions lack of M distinctions 0.97 < 0.0001
lack of T distinctions lack of person agreement distinctions 0.95 < 0.0001
lack of T distinctions lack of overtly expressed arguments A and S 0.88 0.0017
lack of T distinctions case marking / adpositions on verbs 0.76 0.0181
lack of A distinctions lack of M distinctions 0.91 0.0006
lack of A distinctions lack of person agreement distinctions 0.91 0.0006
lack of A distinctions lack of overtly expressed arguments A and S 0.95 0.0001
lack of A distinctions case marking / adpositions on verbs 0.65 0.0576
lack of M distinctions lack of person agreement distinctions 0.95 0.0001
lack of M distinctions lack of overtly expressed arguments A and S 0.87 0.0022
lack of M distinctions case marking / adpositions on verbs 0.82 0.0067
lack of person agreement distinctions lack of overtly expressed arguments A and S 0.82 0.0074
lack of person agreement distinctions case marking / adpositions on verbs 0.76 0.0186
lack of overtly expressed arguments A and S case marking / adpositions on verbs 0.55 0.1217



Complement relations: significant correlations
data data rho p
lack of T distinctions lack of A distinctions 0.94 0.0001
lack of T distinctions lack of M distinctions 0.97 < 0.0001
lack of T distinctions lack of person agreement distinctions 0.95 < 0.0001
lack of T distinctions lack of overtly expressed arguments A and S 0.88 0.0017
lack of T distinctions case marking / adpositions on verbs 0.76 0.0181
lack of A distinctions lack of M distinctions 0.91 0.0006
lack of A distinctions lack of person agreement distinctions 0.91 0.0006
lack of A distinctions lack of overtly expressed arguments A and S 0.95 0.0001
lack of A distinctions case marking / adpositions on verbs 0.65 0.0576
lack of M distinctions lack of person agreement distinctions 0.95 0.0001
lack of M distinctions lack of overtly expressed arguments A and S 0.87 0.0022
lack of M distinctions case marking / adpositions on verbs 0.82 0.0067
lack of person agreement distinctions lack of overtly expressed arguments A and S 0.82 0.0074
lack of person agreement distinctions case marking / adpositions on verbs 0.76 0.0186
lack of overtly expressed arguments A and S case marking / adpositions on verbs 0.55 0.1217



Complement relations: significant correlations
data data rho p
lack of T distinctions lack of A distinctions 0.94 0.0001
lack of T distinctions lack of M distinctions 0.97 < 0.0001
lack of T distinctions lack of person agreement distinctions 0.95 < 0.0001
lack of T distinctions lack of overtly expressed arguments A and S 0.88 0.0017
lack of A distinctions lack of M distinctions 0.91 0.0006
lack of A distinctions lack of person agreement distinctions 0.91 0.0006
lack of A distinctions lack of overtly expressed arguments A and S 0.95 0.0001
lack of M distinctions lack of person agreement distinctions 0.95 0.0001
lack of M distinctions lack of overtly expressed arguments A and S 0.87 0.0022
lack of person agreement distinctions lack of overtly expressed arguments A and S 0.82 0.0074



Complement relations: scales

lack of T 
distinctions

lack of A 
distinctions

lack of M 
distinctions

lack of person 
agreement 
distinctions

lack of overtly 
expressed 
arguments A and S

SUM

Desideratives (want to) 3 4 4 5 4 20
Knowledge (know that) 7 9 7 7 9 39
Manipulatives (make) 6 5 6 6 5 28
Manipulatives (order) 4 3 4 4 3 18
Modals (can, must) 1 1 2 1 1 6
Perception (see someone Xing) 5 6 5 4 9 29
Phasals (begin to) 2 3 1 2 2 10
Propositional attitude (believe that) 9 9 9 8 9 44
Utterance (say that) 9 9 8 9 9 44



Complement relations: combined scale

Modals (can, must) 6
Phasals (begin to) 10
Manipulatives (order) 18
Desideratives (want to) 20
Manipulatives (make) 28
Perception (see someone Xing) 29
Knowledge (know that) 39
Propositional attitude (believe that) 44
Utterance (say that) 44



Complement relations: summary scale

Modals (can, must)
> Phasals (begin to)
> Manipulatives (order)
> Desideratives (want to)
> Manipulatives (make)
> Perception (see someone Xing)
> Knowledge (know that)
> Propositional attitude (believe that), Utterance (say that)



Complement relations: scale for case-
marking/adpositions

Phasals (begin to) 1
Manipulatives (order) 2
Perception (see someone Xing) 3
Desideratives (want to) 4
Modals (can, must) 5
Knowledge (know that) 6
Manipulatives (make) 8
Utterance (say that) 8
Propositional attitude (believe that) 9



Complement relations: summary scale for 
case-marking/adpositions

Phasals (begin to)
> Manipulatives (order)
> Perception (see someone Xing)
> Desideratives (want to)
> Modals (can, must)
> Knowledge (know that)
> Manipulatives (make), Utterance (say that)
> Propositional attitude (believe that)



Complement relations: comparison with Cristofaro

Modals (can, must)
> Phasals (begin to)
> Manipulatives (order)
> Desideratives (want to)
> Manipulatives (make)
> Perception (see someone Xing)
> Knowledge (know that)
> Propositional attitude (believe that), Utterance (say that)

Modals (can, must), Phasals (begin to)
> Desideratives (want to), Manipulatives (order), Manipulatives (make)
> Perception (see someone Xing)
> Knowledge (know that), Propositional attitude (believe that), Utterance (say that)

(‘The Complement Deranking Hierarchy’, Cristofaro 2003: 125)



Complement relations: comparison with Cristofaro

Modals (can, must)
> Phasals (begin to)
> Manipulatives (order)
> Desideratives (want to)
> Manipulatives (make)
> Perception (see someone Xing)
> Knowledge (know that)
> Propositional attitude (believe that), Utterance (say that)

Modals (can, must), Phasals (begin to)
> Desideratives (want to), Manipulatives (order), Manipulatives (make)
> Perception (see someone Xing)
> Knowledge (know that), Propositional attitude (believe that), Utterance (say that)

(‘The Complement Deranking Hierarchy’, Cristofaro 2003: 125)

mergers



Complement relations and case-marking/ 
adpositions : comparison with Cristofaro

Modals (can, must), Phasals (begin to), Desideratives (want to),
Manipulatives (order), Manipulatives (make),  Perception (see someone Xing)
> Knowledge (know that), Propositional attitude (believe that), Utterance (say that)

(‘The Complement Deranking Hierarchy’, Cristofaro 2003: 125)

Phasals (begin to)
> Manipulatives (order)
> Perception (see someone Xing)
> Desideratives (want to)
> Modals (can, must)
> Knowledge (know that)
> Manipulatives (make), Utterance (say that)
> Propositional attitude (believe that)

“…the data on case marking/adpositions are quite
scanty, and the reciprocal ranking of the various
relation types cannot be established due to a lack
of significant languages. This makes it impossible
to define any internal boundaries within the two
blocks in the hierarchy. However, the hierarchy
basically reflects the Complement Deranking
Hierarchy…” (Cristofaro 2003: 128)



Complement relations and case-marking/ 
adpositions : comparison with Cristofaro

Modals (can, must), Phasals (begin to), Desideratives (want to),
Manipulatives (order), Manipulatives (make),  Perception (see someone Xing)
> Knowledge (know that), Propositional attitude (believe that), Utterance (say that)

(Cristofaro 2003: 128)

Phasals (begin to)
> Manipulatives (order)
> Perception (see someone Xing)
> Desideratives (want to)
> Modals (can, must)
> Knowledge (know that)
> Manipulatives (make), Utterance (say that)
> Propositional attitude (believe that)

mergers

“…the data on case marking/adpositions are quite
scanty, and the reciprocal ranking of the various
relation types cannot be established due to a lack
of significant languages. This makes it impossible
to define any internal boundaries within the two
blocks in the hierarchy. However, the hierarchy
basically reflects the Complement Deranking
Hierarchy…” (Cristofaro 2003: 128)



Complement relations: comparing the general 
hierarchy with the one for case marking/adpositions

Modals (can, must)
> Phasals (begin to)
> Manipulatives (order)
> Desideratives (want to)
> Manipulatives (make)
> Perception (see someone Xing)
> Knowledge (know that)
> Propositional attitude (believe that), 

Utterance (say that)

Phasals (begin to)
> Manipulatives (order)
> Perception (see someone Xing)
> Desideratives (want to)
> Modals (can, must)
> Knowledge (know that)
> Manipulatives (make), Utterance (say that)
> Propositional attitude (believe that)

Not right to say that the two hierarchies are basically isomorphic!

Case-marking / adpositionsComplement deranking hierarchy



Adverbial relations: Guttman scaling, all tables

data GCorig GCimp p 1s 0s sum
T distinctions expressed differently from independent clauses 95.83 96.30 0.8714 11 13 24
A distinctions expressed differently from independent clauses 96.97 97.44 0.0078 13 20 33
M distinctions expressed differently from independent clauses 100.00 100.00 NA 16 17 33
lack of person agreement distinctions 99.36 99.29 0.0288 38 119 157
person agreement distinctions expressed differently from independent clauses 100.00 100.00 NA 7 10 17
case marking / adpositions on verbs 100.00 100.00 NA 44 27 71
lack of overtly expressed arguments A and S 99.67 99.58 0.0006 23 280 303
Arguments A and S coded as possessors 100.000 100.00 NA 7 15 22
lack of T distinctions 99.13 99.23 0.0001 67 164 231
lack of A distinctions 98.99 98.89 0.0001 63 234 297
lack of M distinctions 98.46 98.38 0.0001 76 183 259



Adverbial relations: significant tables

data GCorig GCimp p 1s 0s sum
A distinctions expressed differently from independent clauses 96.97 97.44 0.0078 13 20 33
lack of person agreement distinctions 99.36 99.29 0.0288 38 119 157
lack of overtly expressed arguments A and S 99.67 99.58 0.0006 23 280 303
lack of T distinctions 99.13 99.23 0.0001 67 164 231
lack of A distinctions 98.99 98.89 0.0001 63 234 297
lack of M distinctions 98.46 98.38 0.0001 76 183 259



Adverbial relations: correlations
data data rho p
lack of T distinctions lack of A distinctions 0.95 0.0039
lack of T distinctions lack of M distinctions 0.89 0.0168
lack of T distinctions lack of person agreement distinctions 0.90 0.0155
lack of T distinctions A distinctions expressed differently from independent clauses 0.23 0.6596
lack of T distinctions lack of overtly expressed arguments A and S 0.40 0.4363
lack of A distinctions lack of M distinctions 0.95 0.0042
lack of A distinctions lack of person agreement distinctions 0.95 0.0039
lack of A distinctions A distinctions expressed differently from independent clauses 0.23 0.6596
lack of A distinctions lack of overtly expressed arguments A and S 0.54 0.2694
lack of M distinctions lack of person agreement distinctions 0.84 0.0374
lack of M distinctions A distinctions expressed differently from independent clauses 0.24 0.6412
lack of M distinctions lack of overtly expressed arguments A and S 0.42 0.4084
lack of person agreement distinctions A distinctions expressed differently from independent clauses 0.00 1.000
lack of person agreement distinctions lack of overtly expressed arguments A and S 0.68 0.1355
A distinctions expressed differently from 
independent clauses lack of overtly expressed arguments A and S -0.56 0.2497



Adverbial relations: correlations
data data rho p
lack of T distinctions lack of A distinctions 0.95 0.0039
lack of T distinctions lack of M distinctions 0.89 0.0168
lack of T distinctions lack of person agreement distinctions 0.90 0.0155
lack of T distinctions A distinctions expressed differently from independent clauses 0.23 0.6596
lack of T distinctions lack of overtly expressed arguments A and S 0.40 0.4363
lack of A distinctions lack of M distinctions 0.95 0.0042
lack of A distinctions lack of person agreement distinctions 0.95 0.0039
lack of A distinctions A distinctions expressed differently from independent clauses 0.23 0.6596
lack of A distinctions lack of overtly expressed arguments A and S 0.54 0.2694
lack of M distinctions lack of person agreement distinctions 0.84 0.0374
lack of M distinctions A distinctions expressed differently from independent clauses 0.24 0.6412
lack of M distinctions lack of overtly expressed arguments A and S 0.42 0.4084
lack of person agreement distinctions A distinctions expressed differently from independent clauses 0.00 1.000
lack of person agreement distinctions lack of overtly expressed arguments A and S 0.68 0.1355
A distinctions expressed differently from 
independent clauses lack of overtly expressed arguments A and S -0.56 0.2497



Adverbial relations: significant correlations

data data rho p
lack of T distinctions lack of A distinctions 0.95 0.0039
lack of T distinctions lack of M distinctions 0.89 0.0168
lack of T distinctions lack of person agreement distinctions 0.90 0.0155
lack of A distinctions lack of M distinctions 0.95 0.0042
lack of A distinctions lack of person agreement distinctions 0.95 0.0039
lack of M distinctions lack of person agreement distinctions 0.84 0.0374



Adverbial relations: scales

lack of T 
distinctions

lack of A 
distinctions

lack of M 
distinctions

lack of person 
agreement 
distinctions

SUM

Temporal anteriority (after relations) 2 2 2 3 9
Temporal posteriority (before relations) 3 3 4 2 12
Purpose 1 1 1 1 4
Reality condition 5 6 6 6 23
Reason 6 5 5 5 21
Temporal overlap (when relations) 5 5 4 5 19



Adverbial relations: combined scale

Purpose 4
Temporal anteriority (after relations) 9
Temporal posteriority (before relations) 12
Temporal overlap (when relations) 19
Reason 21
Reality condition 23



Adverbial relations: summary scale

Purpose
> Temporal anteriority (after relations)
> Temporal posteriority (before relations)
> Temporal overlap (when relations)
> Reason
> Reality condition



Adverbial relations: comparison with Cristofaro

Purpose
> Temporal anteriority (after relations)
> Temporal posteriority (before relations)
> Temporal overlap (when relations)
> Reason
> Reality condition

Purpose
> Temporal anteriority, Temporal posteriority, Temporal overlap
> Reason, Reality condition

(‘The Adverbial Deranking Hierarchy’, Cristofaro 2003: 168)



Adverbial relations: comparison with Cristofaro

Purpose
> Temporal anteriority (after relations)
> Temporal posteriority (before relations)
> Temporal overlap (when relations)
> Reason
> Reality condition

Purpose
> Temporal anteriority, Temporal posteriority, Temporal overlap
> Reason, Reality condition

mergers

(‘The Adverbial Deranking Hierarchy’, Cristofaro 2003: 168)



Relative relations: Guttman scaling

data GCorig GCimp p 1s 0s sum
lack of person agreement distinctions 100 100 NA 42 111 153
case marking adpositions on verbs 100 100 NA 27 6 33
gapping of the relativized item 100 100 NA 139 128 267
Arguments A or S coded as possessors 100 100 NA 4 2 6
lack of T distinctions 100 100 NA 45 192 237
lack of A distinctions 100 100 NA 22 260 282
lack of M distinctions 100 100 NA 62 197 259
T distinctions expressed differently from independent clauses 100 100 NA 23 5 28
A distinctions expressed differently from independent clauses 100 100 NA 25 7 32
M distinctions expressed differently from independent clauses 100 100 NA 8 2 10
case marking adpositions on verbs 100 100 NA 44 27 71



Relative relations: significant tables

data GCorig GCimp p 1s 0s sum
lack of person agreement distinctions 100 100 1 42 111 153
gapping of the relativized item 100 100 1 139 128 267
lack of T distinctions 100 100 1 45 192 237
lack of A distinctions 100 100 1 22 260 282
lack of M distinctions 100 100 1 62 197 259



Relative relations: correlations
data data rho p
lack of T distinctions lack of A distinctions 0.84 0.0718
lack of T distinctions lack of M distinctions 0.96 0.0092

lack of T distinctions lack of person agreement distinctions 0.96 0.0092

lack of T distinctions gapping of the relativized item 0.94 0.0182
lack of A distinctions lack of M distinctions 0.88 0.0496

lack of A distinctions lack of person agreement distinctions 0.88 0.0496

lack of A distinctions gapping of the relativized item 0.96 0.0098

lack of M distinctions lack of person agreement distinctions 1.00 0.0000

lack of M distinctions gapping of the relativized item 0.97 0.0062
lack of person agreement 
distinctions gapping of the relativized item 0.97 0.0062



Relative relations: scales

lack of T 
distinctions

lack of A 
distinctions

lack of M 
distinctions

lack of person 
agreement 
distinctions

gapping of the 
relativized item

SUM

A 1 3 1 1 2 8
Indirect Object 4 4 3 3 4 18
Oblique 4 5 4 4 5 22
O 2 3 2 2 3 12
S 1 1 1 1 1 5



Relative relations: combined scale

S 5
A 8
O 12
Indirect Object 18
Oblique 22



Relative relations: summary scale

S
> A
> O
> Indirect Object
> Oblique



Relative relations: comparison with Cristofaro

S
> A
> O
> Indirect Object
> Oblique

S, A
> O
> Indirect Object, Oblique

(‘The Relative Deranking-Argument Hierarchy’, Cristofaro 2003: 207)



Relative relations: comparison with Cristofaro

S
> A
> O
> Indirect Object
> Oblique

S, A
> O
> Indirect Object, Oblique

mergers

(‘The Relative Deranking-Argument Hierarchy’, Cristofaro 2003: 207)



Summary of empirical findings: general

• Tsunoda’s implicational scales of verb meanings did not hold up very well 
for neither alternations nor argument coding frames

• There are implicational scales, but they are somewhat different from
Tsunoda’s

• The psychological temptation to expect grammar to reflect semantic
classes should be avoided—classes should come from the data, not from
intuitions

• Cristofaro’s scales generally hold up, but there are in all cases unnecessary
mergers

• For complement relations the general deranking hierarchy and the one for 
case marking/adpositions only fit each other after a merging members of 
the latter hierarchy which is otherwise not motivated.



Summary of empirical findings: new hierarchies

• The Complement Deranking Hierarchy
• Modals (can, must) > Phasals (begin to) > Manipulatives (order) > Desideratives

(want to) > Manipulatives (make) > Perception (see someone Xing) > Knowledge 
(know that) > Propositional attitude (believe that), Utterance (say that)

• The Adverbial Deranking Hierarchy
• Purpose > Temporal anteriority (after relations) > Temporal posteriority (before 

relations) > Temporal overlap (when relations) > Reason > Reality condition

• The Relative Deranking-Argument Hierarchy
• S > A > O > Indirect Object > Oblique



Summary of theoretical results

• Introduction of a statistical test which efficiently allows to measure
the significance of a putative implicational scale

• Introduction of a meaningful way of compensating for missing data by
imputation

• Outstanding problem: for a perfect implicational scale (Guttman
coefficient = 100%) the significance test does not apply
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